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ASAv on VMware Guidelines and Limitations
You can create and deploy multiple instances of the ASAv on an ESXi server. The specific hardware used
for ASAv deployments can vary, depending on the number of instances deployed and usage requirements.
Each virtual appliance you create requires a minimum resource allocation—memory, number of CPUs, and
disk space—on the host machine.

Review the following guidelines and limitations before you deploy the ASAv.

ASAv on VMware ESXi System Requirements

Make sure to conform to the specifications below to ensure optimal performance. The ASAvASAv has the
following requirements:

• The host CPU must be a server class x86-based Intel or AMD CPU with virtualization extension.

For example, ASAv performance test labs use as minimum the following: Cisco Unified Computing
System™ (Cisco UCS®) C series M4 server with the Intel® Xeon® CPU E5-2690v4 processors running
at 2.6GHz.

• ASAv supports ESXi version 6.0, 6.5, 6.7, 7.0, 7.0 Upgrade 1, 7.0 Upgrade 2, and 7.0 Upgrade 3.
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OVF File Guidelines

The selection of the asav-vi.ovf or asav-esxi.ovf file is based on the deployment target:

• asav-vi—For deployment on vCenter

• asav-esxi—For deployment on ESXi (no vCenter)

• The ASAv OVF deployment does not support localization (installing the components in non-English
mode). Be sure that the VMware vCenter and the LDAP servers in your environment are installed in an
ASCII-compatible mode.

• You must set your keyboard to United States English before installing the ASAv and for using the VM
console.

• When the ASAv is deployed, two different ISO images are mounted on the ESXi hypervisor:

• The first drive mounted has the OVF environment variables generated by vSphere.

• The second drive mounted is the day0.iso.

You can unmount both drives after the ASAv machine has booted. However,
Drive 1 (with the OVF environment variables) will always be mounted every
time the ASAv is powered off/on, even if Connect at Power On is unchecked.

Attention

Export OVF Template Guidelines

The Export OVF Template in vSphere helps you export an existing ASAv instance package as an OVF
template. You can use an exported OVF template for deploying the ASAv instance in the same or different
environment. Before deploying the ASAv instance using an exported OVF template on vSphere, you must
modify the configuration details in the OVF file to prevent deployment failure.

To modify the exported OVF file of ASAv.

1. Log in to the local machine where you have exported the OVF template.

2. Browse and open the OVF file in a text editor.

3. Ensure that the tag <vmw:ExtraConfig vmw:key="monitor_control.pseudo_perfctr"

vmw:value="TRUE"></vmw:ExtraConfig> is present.

4. Delete the tag <rasd:ResourceSubType>vmware.cdrom.iso</rasd:ResourceSubType>.

Or

Replace the tag <rasd:ResourceSubType>vmware.cdrom.iso</rasd:ResourceSubType> with
<rasd:ResourceSubType>vmware.cdrom.remotepassthrough</rasd:ResourceSubType>.

See the Deploying an OVF fails on vCenter Server 5.1/5.5 when VMware tools are installed (2034422)
published by VMware for more information.

5. Enter the property values for UserPrivilege, OvfDeployment, and ControllerType.

For example:
- <Property ovf:qualifiers="ValueMap{"ovf", "ignore", "installer"}" ovf:type="string"
ovf:key="OvfDeployment">
+ <Property ovf:qualifiers="ValueMap{"ovf", "ignore", "installer"}" ovf:type="string"
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ovf:key="OvfDeployment" ovf:value="ovf">

- <Property ovf:type="string" ovf:key="ControllerType">
+ <Property ovf:type="string" ovf:key="ControllerType" ovf:value="ASAv">

- <Property ovf:qualifiers="MinValue(0) MaxValue(255)" ovf:type="uint8"
ovf:key="UserPrivilege">
+ <Property ovf:qualifiers="MinValue(0) MaxValue(255)" ovf:type="uint8"
ovf:key="UserPrivilege" ovf:value="15">

6. Save the OVF file.

7. Deploy the ASAv using the OVF template. See, Deploy the ASAv Using the VMware vSphere Web
Client.

Failover for High Availability Guidelines

For failover deployments, make sure that the standby unit has the same license entitlement; for example, both
units should have the 2Gbps entitlement.

When creating a high availability pair using ASAv, it is necessary to add the data interfaces to each ASAv in
the same order. If the exact same interfaces are added to each ASAv, but in different order, errors may be
presented at the ASAv console. Failover functionality may also be affected.

Important

For the ESX port group used for ASAv Inside interface or ASAv failover high availability link, configure the
ESX port group failover order with two virtual NICs – one as active uplink and the other as standby uplink.
This is necessary for the two VMs to ping each other or ASAv high availability link to be up.

vMotion Guidelines

• VMware requires that you only use shared storage if you plan to use vMotion. During ASAv deployment,
if you have a host cluster you can either provision storage locally (on a specific host) or on a shared host.
However, if you try to vMotion the ASAv to another host, using local storage will produce an error.

Memory and vCPU Allocation for Throughput and Licensing

• The memory allocated to the ASAv is sized specifically for the throughput level. Do not change the
memory setting or any vCPU hardware settings in the Edit Settings dialog box unless you are requesting
a license for a different throughput level. Under-provisioning can affect performance.

If you need to change the memory or vCPU hardware settings, use only the values
documented in Licensing for the ASAv. Do not use the VMware-recommended
memory configuration minimum, default, and maximum values.

Note

In some situations, the ASAv5may experiencememory exhaustion. This can occur during certain resource
heavy applications, such as enabling AnyConnect Client or downloading files. Console messages related
to spontaneous reboots or critical syslogs related to memory usage are symptoms of memory exhaustion.
In these cases, you can enable the ASAv5 to be deployed in a VM with 1.5 GB of memory. To change
from 1GB to 1.5GB, power down your VM, modify the memory, and power the VM back on.
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CPU Reservation

• By default the CPU reservation for the ASAv is 1000MHz. You can change the amount of CPU resources
allocated to the ASAv by using the shares, reservations, and limits settings (Edit Settings > Resources
> CPU). Lowering the CPU Reservation setting from 1000 Mhz can be done if the ASAv can perform
its required purpose while under the required traffic load with the lower setting. The amount of CPU
used by an ASAv depends on the hardware platform it is running on as well as the type and amount of
work it is doing.

You can view the host’s perspective of CPU usage for all of your virtual machines from the CPU Usage
(MHz) chart, located in the Home view of the Virtual Machine Performance tab. Once you establish a
benchmark for CPU usage when the ASAv is handling typical traffic volume, you can use that information
as input when adjusting the CPU reservation.

See the CPU Performance Enhancement Advice published by VMware for more information.

• You can use the ASAv show vm and show cpu commands or the ASDM Home > Device Dashboard >
Device Information > Virtual Resources tab or the Monitoring > Properties > System Resources
Graphs >CPU pane to view the resource allocation and any resources that are over- or under-provisioned.

Transparent Mode on UCS B Series Hardware Guidelines

MAC flaps have been observed in some ASAv configurations running in transparent mode on Cisco UCS B
Series hardware. When MAC addresses appear from different locations you will get dropped packets.

The following guidelines help preventMAC flaps when you deploy the ASAv in transparent mode in VMware
environments:

• VMware NIC teaming—If deploying the ASAv in transparent mode on UCS B Series, the Port Groups
used for the Inside and Outside interfaces must have only 1 Active Uplink, and that uplink must be the
same. You configure VMware NIC teaming in vCenter.

See the VMware documentation for complete information on how to configure NIC teaming.

• ARP inspection—Enable ARP inspection on the ASAv and statically configure the MAC and ARP entry
on the interface you expect to receive it on. See the Cisco ASA Series General Operations Configuration
Guide for information about ARP inspection and how to enable it.

Additional Guidelines and Limitations

• The ASA Virtual boots without the two CD/DVD IDE drives if you are running ESXi 6.7, vCenter 6.7,
ASA Virtual 9.12 and above.

• The vSphere Web Client is not supported for ASAv OVF deployment; use the vSphere client instead.

VMware Feature Support for the ASAv
The following table lists the VMware feature support for the ASAv.
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Table 1: VMware Feature Support for the ASAv

CommentSupport (Yes/No)DescriptionFeature

¯YesThe VM is powered off
during cloning.

Cold Clone

See VMware guidelines.

YesUsed for dynamic
resource scheduling and
distributed power
management.

DRS

¯NoTheVM is running during
an addition.

Hot add

¯NoTheVM is running during
cloning.

Hot clone

¯NoTheVM is running during
removal.

Hot removal

Use with care. You may
lose traffic. Failover may
occur.

YesThe VM freezes for a few
seconds.

Snapshot

¯YesThe VM is suspended,
then resumed.

Suspend and resume

¯NoAllows automatic
deployment of VMs.

vCloud Director

¯YesThe VM is powered off
during migration.

VM migration

Use shared storage. See
vMotion Guidelines, on
page 3.

YesUsed for live migration of
VMs.

vMotion

Use ASAv failover for
ASAv machine failures.

NoUsed for HA on VMs.VMware FT

Use ASAv failover for
ASAv machine failures.

YesUsed for ESXi and server
failures.

VMware HA

Use ASAv failover for
ASAv machine failures.

NoUsed for VM failures.VMware HA with VM
heartbeats

¯
YesUsed to deploy VMs.VMware vSphere

Standalone Windows
Client

¯YesUsed to deploy VMs.VMware vSphere Web
Client
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Prerequisites for the ASAv and VMware
You can deploy the ASAv using the VMware vSphere Web Client, vSphere standalone client, or the OVF
tool. See Cisco ASA Compatibility for system requirements.

Security Policy for a vSphere Standard Switch

For a vSphere switch, you can edit Layer 2 security policies and apply security policy exceptions for port
groups used by the ASAv interfaces. See the following default settings:

• Promiscuous Mode: Reject

• MAC Address Changes: Accept

• Forged Transmits: Accept

Youmay need to modify these settings for the following ASAv configurations. See the vSphere documentation
for more information.

Table 2: Port Group Security Policy Exceptions

Transparent Firewall ModeRouted Firewall Mode

Security Exception FailoverNo FailoverFailoverNo Failover

AcceptAccept<any><any>Promiscuous Mode

Accept<any>Accept<any>MAC Address
Changes

AcceptAcceptAccept<any>Forged Transmits

Unpack the ASAv Software and Create a Day 0 Configuration
File

You can prepare a Day 0 configuration file before you launch the ASAv. This file is a text file that contains
the ASAv configuration to be applied when the ASAv is launched. This initial configuration is placed into a
text file named “day0-config” in a working directory you chose, and is manipulated into a day0.iso file that
is mounted and read on first boot. At the minimum, the Day 0 configuration file must contain commands to
activate the management interface and set up the SSH server for public key authentication, but it can also
contain a complete ASA configuration. A default day0.iso containing an empty day0-config is provided with
the release. The day0.iso file (either your custom day0.iso or the default day0.iso) must be available during
first boot.

Before you begin

We are using Linux in this example, but there are similar utilities for Windows.
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• To automatically license the ASAv during initial deployment, place the Smart Licensing Identity (ID)
Token that you downloaded from the Cisco Smart Software Manager in a text file named ‘idtoken’ in
the same directory as the Day 0 configuration file.

• If you want to deploy the ASAv in transparent mode, you must use a known running ASA config file in
transparent mode as the Day 0 configuration file. This does not apply to a Day 0 configuration file for a
routed firewall.

• See the OVF file guidelines in ASAv on VMware Guidelines and Limitations, on page 1 for additional
information about how the ISO images are mounted on the ESXi hypervisor.

Procedure

Step 1 Download the ZIP file from Cisco.com, and save it to your local disk:

https://www.cisco.com/go/asa-software

A Cisco.com login and Cisco service contract are required.Note

Step 2 Unzip the file into a working directory. Do not remove any files from the directory. The following files are
included:

• asav-vi.ovf—For vCenter deployments.

• asav-esxi.ovf—For non-vCenter deployments.

• boot.vmdk—Boot disk image.

• disk0.vmdk—ASAv disk image.

• day0.iso—An ISO containing a day0-config file and optionally an idtoken file.

• asav-vi.mf—Manifest file for vCenter deployments.

• asav-esxi.mf—Manifest file for non-vCenter deployments.

Step 3 Enter the CLI configuration for the ASAv in a text file called “day0-config.” Add interface configurations
for the three interfaces and any other configuration you want.

The fist line should begin with the ASA version. The day0-config should be a valid ASA configuration. The
best way to generate the day0-config is to copy the desired parts of a running config from an existing ASA
or ASAv. The order of the lines in the day0-config is important and should match the order seen in an existing
show running-config command output.

Example:
ASA Version 9.4.1
!
console serial
interface management0/0
nameif management
security-level 100
ip address 192.168.1.1 255.255.255.0
no shutdown
interface gigabitethernet0/0
nameif inside
security-level 100
ip address 10.1.1.2 255.255.255.0
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no shutdown
interface gigabitethernet0/1
nameif outside
security-level 0
ip address 198.51.100.2 255.255.255.0
no shutdown
http server enable
http 192.168.1.0 255.255.255.0 management
crypto key generate rsa modulus 1024
username AdminUser password paSSw0rd
ssh 192.168.1.0 255.255.255.0 management
aaa authentication ssh console LOCAL
call-home
http-proxy 10.1.1.1 port 443
license smart
feature tier standard
throughput level 2G

Step 4 (Optional) Download the Smart License identity token file issued by the Cisco Smart Software Manager to
your PC.

Step 5 (Optional) Copy the ID token from the download file and put it in a text file named ‘idtoken’ that only contains
the ID token.

The Identity Token automatically registers the ASAv with the Smart Licensing server.

Step 6 Generate the virtual CD-ROM by converting the text file to an ISO file:

Example:
stack@user-ubuntu:-/KvmAsa$ sudo genisoimage -r -o day0.iso day0-config idtoken
I: input-charset not specified, using utf-8 (detected in locale settings)
Total translation table size: 0
Total rockridge attributes bytes: 252
Total directory bytes: 0
Path table size (byptes): 10
Max brk space used 0
176 extents written (0 MB)
stack@user-ubuntu:-/KvmAsa$

Step 7 Compute a new SHA1 value on Linux for the day0.iso:

Example:
openssl dgst -sha1 day0.iso
SHA1(day0.iso)= e5bee36e1eb1a2b109311c59e2f1ec9f731ecb66 day0.iso

Step 8 Include the new checksum in the asav-vi.mf file in the working directory and replace the day0.iso SHA1 value
with the newly generated one.

Example:
SHA1(asav-vi.ovf)= de0f1878b8f1260e379ef853db4e790c8e92f2b2
SHA1(disk0.vmdk)= 898b26891cc68fa0c94ebd91532fc450da418b02
SHA1(boot.vmdk)= 6b0000ddebfc38ccc99ac2d4d5dbfb8abfb3d9c4
SHA1(day0.iso)= e5bee36e1eb1a2b109311c59e2f1ec9f731ecb66

Step 9 Copy the day0.iso file into the directory where you unzipped the ZIP file. You will overwrite the default
(empty) day0.iso file.

When any VM is deployed from this directory, the configuration inside the newly generated day0.iso is applied.
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Deploy the ASAv Using the VMware vSphere Web Client
This section describes how to deploy the ASAv using the VMware vSphere Web Client. The Web Client
requires vCenter. If you do not have vCenter, see Deploy the ASAv Using the VMware vSphere Standalone
Client and Day 0 Configuration, or Deploy the ASAv Using the OVF Tool and Day 0 Configuration.

• Access the vSphere Web Client and Install the Client Integration Plug-In, on page 9

• Deploy the ASAv Using the VMware vSphere Web Client, on page 9

Access the vSphere Web Client and Install the Client Integration Plug-In
This section describes how to access the vSphere Web Client. This section also describes how to install the
Client Integration Plug-In, which is required for ASAv console access. Some Web Client features (including
the plug-in) are not supported on the Macintosh. See the VMware website for complete client support
information.

Procedure

Step 1 Launch the VMware vSphere Web Client from your browser:

https://vCenter_server:port/vsphere-client/

By default, the port is 9443.

Step 2 (One time only) Install the Client Integration Plug-in so that you can access the ASAv console.

a. In the login screen, download the plug-in by clicking Download the Client Integration Plug-in.

b. Close your browser and then install the plug-in using the installer.

c. After the plug-in installs, reconnect to the vSphere Web Client.

Step 3 Enter your username and password, and click Login, or check the Use Windows session authentication
check box (Windows only).

Deploy the ASAv Using the VMware vSphere Web Client
To deploy the ASAv, use the VMware vSphere Web Client (or the vSphere Client) and a template file in the
open virtualization format (OVF). You use the Deploy OVF Template wizard in the vSphere Web Client to
deploy the Cisco package for the ASAv. The wizard parses the ASAv OVF file, creates the virtual machine
on which you will run the ASAv, and installs the package.

Most of the wizard steps are standard for VMware. For additional information about the Deploy OVF Template,
see the VMware vSphere Web Client online help.

Before you begin

You must have at least one network configured in vSphere (for management) before you deploy the ASAv.
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Procedure

Step 1 Download the ASAv ZIP file from Cisco.com, and save it to your PC:

http://www.cisco.com/go/asa-software

A Cisco.com login and Cisco service contract are required.Note

Step 2 In the vSphere Web Client Navigator pane, click vCenter.
Step 3 Click Hosts and Clusters.
Step 4 Right-click the data center, cluster, or host where you want to deploy the ASAv, and choose Deploy OVF

Template.
The Deploy OVF Template wizard appears.

Step 5 Follow the wizard screens as directed.
Step 6 In the Setup networks screen, map a network to each ASAv interface that you want to use.

The networks may not be in alphabetical order. If it is too difficult to find your networks, you can change the
networks later from the Edit Settings dialog box. After you deploy, right-click the ASAv instance, and choose
Edit Settings to access the Edit Settings dialog box. However that screen does not show the ASAv interface
IDs (only Network Adapter IDs). See the following concordance of Network Adapter IDs and ASAv interface
IDs:

ASAv Interface IDNetwork Adapter ID

Management 0/0Network Adapter 1

GigabitEthernet 0/0Network Adapter 2

GigabitEthernet 0/1Network Adapter 3

GigabitEthernet 0/2Network Adapter 4

GigabitEthernet 0/3Network Adapter 5

GigabitEthernet 0/4Network Adapter 6

GigabitEthernet 0/5Network Adapter 7

GigabitEthernet 0/6Network Adapter 8

GigabitEthernet 0/7Network Adapter 9

GigabitEthernet 0/8Network Adapter 10

You do not need to use all ASAv interfaces; however, the vSphereWeb Client requires you to assign a network
to all interfaces. For interfaces you do not intend to use, you can simply leave the interface disabled within
the ASAv configuration. After you deploy the ASAv, you can optionally return to the vSphere Web Client
to delete the extra interfaces from the Edit Settings dialog box. For more information, see the vSphere Web
Client online help.

For failover/HA deployments, GigabitEthernet 0/8 is preconfigured as the failover interface.Note
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Step 7 If your network uses an HTTP proxy for Internet access, you must configure the proxy address for smart
licensing in the Smart Call Home Settings area. This proxy is also used for Smart Call Home in general.

Step 8 For failover/HA deployments, in the Customize template screen, configure the following:

• Specify the standby management IP address.

When you configure your interfaces, you must specify an active IP address and a standby IP address on
the same network. When the primary unit fails over, the secondary unit assumes the IP addresses and
MAC addresses of the primary unit and begins passing traffic. The unit that is now in a standby state
takes over the standby IP addresses and MAC addresses. Because network devices see no change in the
MAC to IP address pairing, no ARP entries change or time out anywhere on the network.

• Configure the failover link settings in the HA Connection Settings area.

The two units in a failover pair constantly communicate over a failover link to determine the operating
status of each unit. GigabitEthernet 0/8 is preconfigured as the failover link. Enter the active and standby
IP addresses for the link on the same network.

Step 9 After you complete the wizard, the vSphere Web Client processes the VM; you can see the “Initialize OVF
deployment” status in the Global Information area Recent Tasks pane.

When it is finished, you see the Deploy OVF Template completion status.
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The ASAv machine instance then appears under the specified data center in the Inventory.
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Step 10 If the ASAv machine is not yet running, click Power On the virtual machine.

Wait for the ASAv to boot up before you try to connect with ASDM or to the console. When the ASAv starts
up for the first time, it reads parameters provided through the OVF file and adds them to the ASAv system
configuration. It then automatically restarts the boot process until it is up and running. This double boot process
only occurs when you first deploy the ASAv. To view bootup messages, access the ASAv console by clicking
the Console tab.

Step 11 For failover/HA deployments, repeat this procedure to add the secondary unit. See the following guidelines:

• Set the same throughput level as the primary unit.

• Enter the exact same IP address settings as for the primary unit. The bootstrap configurations on both
units are identical except for the parameter identifying a unit as primary or secondary.
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What to do next

To successfully register the ASAv with the Cisco Licensing Authority, the ASAv requires Internet access.
You might need to perform additional configuration after deployment to achieve Internet access and successful
license registration.

Deploy the ASAv Using the VMware vSphere Standalone Client
and Day 0 Configuration

To deploy the ASAv, use the VMware vSphere Client and the open virtualization format (OVF) template file
(asav-vi.ovf for a vCenter deployment or asav-esxi.ovf for a non-vCenter deployment). You use the Deploy
OVF Template wizard in the vSphere Client to deploy the Cisco package for the ASAv. The wizard parses
the ASAv OVF file, creates the virtual machine on which you will run the ASAv, and installs the package.

Most of the wizard steps are standard for VMware. For additional information about the Deploy OVF Template
wizard, see the VMware vSphere Client online help.

Before you begin

• You must have at least one network configured in vSphere (for management) before you deploy the
ASAv.

• Follow the steps in Unpack the ASAv Software and Create a Day 0 Configuration File, on page 6 to
create the Day 0 configuration.

Procedure

Step 1 Launch the VMware vSphere Client and choose File > Deploy OVF Template.

The Deploy OVF Template wizard appears.

Step 2 Browse to the working directory where you unzipped the asav-vi.ovf file and select it.
Step 3 The OVF Template details are shown. Proceed through the following screens. You do not have to change any

configuration if you choose to use a custom Day 0 configuration file.
Step 4 A summary of the deployment settings is shown in the last screen. Click Finish to deploy the VM.
Step 5 Power on the ASAv, open the VMware console, and wait for the second boot.
Step 6 SSH to the ASAv and complete your desired configuration. If you do not have all the configuration that you

wanted in the Day 0 configuration file, open a VMware console and complete the necessary configuration.

The ASAv is now fully operational.

Deploy the ASAv Using the OVF Tool and Day 0 Configuration
This section describes how to deploy the ASAv using the OVF tool, which requires a day 0 configuration file.
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Before you begin

• The day0.iso file is required when you are deploying the ASAv using the OVF tool. You can use the
default empty day0.iso file provided in the ZIP file, or you can use a customized Day 0 configuration
file that you generate. See Unpack the ASAv Software and Create a Day 0 Configuration File, on page
6 for creating a Day 0 configuration file.

• Make sure the OVF tool is installed on a Linux or Windows PC and that it has connectivity to your target
ESXi server.

Procedure

Step 1 Verify the OVF tool is installed:

Example:
linuxprompt# which ovftool

Step 2 Create a .cmd file with the desired deployment options:

Example:
linuxprompt# cat launch.cmd
ovftool \
--name="asav-941-demo" \
--powerOn \
--deploymentOption=ASAv30 \
--diskMode=thin \
--datastore=datastore1 \
--acceptAllEulas \
--net:Management0-0="Portgroup_Mgmt" \
--net:GigabitEthernet0-1="Portgroup_Inside" \
--net:GigabitEthernet0-0="Portgroup_Outside" \
--prop:HARole=Standalone \
asav-esxi.ovf \
vi://root@10.1.2.3/

Step 3 Execute the cmd file:

Example:
linuxprompt# ./launch.cmd

The ASAv is powered on; wait for the second boot.

Step 4 SSH to the ASAv to complete configuration as needed. If more configuration is required, open the VMware
console to the ASAv and apply the necessary configuration.

The ASAv is now fully operational.

Access the ASAv Console
In some cases with ASDM, you may need to use the CLI for troubleshooting. By default, you can access the
built-in VMware vSphere console. Alternatively, you can configure a network serial console, which has better
capabilities, including copy and paste.
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• Use the VMware vSphere Console

• Configure a Network Serial Console Port

Use the VMware vSphere Console
For initial configuration or troubleshooting, access the CLI from the virtual console provided through the
VMware vSphere Web Client. You can later configure CLI remote access for Telnet or SSH.

Before you begin

For the vSphereWeb Client, install the Client Integration Plug-In, which is required for ASAv console access.

Procedure

Step 1 In the VMware vSphereWeb Client, right-click the ASAv instance in the Inventory, and chooseOpen Console.
Or you can click Launch Console on the Summary tab.

Step 2 Click in the console and press Enter. Note: Press Ctrl + Alt to release the cursor.

If the ASAv is still starting up, you see bootup messages.

When the ASAv starts up for the first time, it reads parameters provided through the OVF file and adds them
to the ASAv system configuration. It then automatically restarts the boot process until it is up and running.
This double boot process only occurs when you first deploy the ASAv.

Until you install a license, throughput is limited to 100 Kbps so that you can perform preliminary
connectivity tests. A license is required for regular operation. You also see the following messages
repeated on the console until you install a license:
Warning: ASAv platform license state is Unlicensed.
Install ASAv platform license for full functionality.

Note

You see the following prompt:
ciscoasa>

This prompt indicates that you are in user EXEC mode. Only basic commands are available from user EXEC
mode.

Step 3 Access privileged EXEC mode:

Example:
ciscoasa> enable

The following prompt appears:
Password:

Step 4 Press the Enter key to continue. By default, the password is blank. If you previously set an enable password,
enter it instead of pressing Enter.

The prompt changes to:
ciscoasa#

All nonconfiguration commands are available in privileged EXEC mode. You can also enter configuration
mode from privileged EXEC mode.
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To exit privileged mode, enter the disable, exit, or quit command.

Step 5 Access global configuration mode:
ciscoasa# configure terminal

The prompt changes to the following:
ciscoasa(config)#

You can begin to configure the ASAv from global configuration mode. To exit global configuration mode,
enter the exit, quit, or end command.

Configure a Network Serial Console Port
For a better console experience, you can configure a network serial port singly or attached to a virtual serial
port concentrator (vSPC) for console access. See the VMware vSphere documentation for details about each
method. On the ASAv, you must send the console output to a serial port instead of to the virtual console. This
procedure describes how to enable the serial port console.

Procedure

Step 1 Configure a network serial port in VMware vSphere. See the VMware vSphere documentation.
Step 2 On the ASAv, create a file called “use_ttyS0” in the root directory of disk0. This file does not need to have

any contents; it just needs to exist at this location:

disk0:/use_ttyS0

• From ASDM, you can upload an empty text file by that name using the Tools > File Management
dialog box.

• At the vSphere console, you can copy an existing file (any file) in the file system to the new name. For
example:
ciscoasa(config)# cd coredumpinfo
ciscoasa(config)# copy coredump.cfg disk0:/use_ttyS0

Step 3 Reload the ASAv.

• From ASDM, choose Tools > System Reload.

• At the vSphere console, enter reload.

The ASAv stops sending to the vSphere console, and instead sends to the serial console.

Step 4 Telnet to the vSphere host IP address and the port number you specified when you added the serial port; or
Telnet to the vSPC IP address and port.
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Upgrade the vCPU or Throughput License
The ASAv uses a throughput license, which affects the number of vCPUs you can use.

If you want to increase (or decrease) the number of vCPUs for your ASAv, you can request a new license,
apply the new license, and change the VM properties in VMware to match the new values.

The assigned vCPUs must match the ASAv CPU license or Throughput license. The RAMmust also be sized
correctly for the vCPUs. When upgrading or downgrading, be sure to follow this procedure and reconcile the
license and vCPUs immediately. The ASAv does not operate properly when there is a persistent mismatch.

Note

Procedure

Step 1 Request a new license.
Step 2 Apply the new license. For failover pairs, apply new licenses to both units.
Step 3 Do one of the following, depending on whether you use failover:

• Failover—In the vSphere Web Client, power off the standby ASAv. For example, click the ASAv and
then click Power Off the virtual machine, or right-click the ASAv and choose Shut Down Guest OS.

• No Failover—In the vSphere Web Client, power off the ASAv. For example, click the ASAv and then
click Power Off the virtual machine, or right-click the ASAv and choose Shut Down Guest OS.

Step 4 Click the ASAv and then click Edit Virtual machine settings (or right-click the ASAv and choose Edit
Settings).

The Edit Settings dialog box appears.

Step 5 Refer to the CPU and memory requirements in Licensing for the ASAv to determine the correct values for
the new vCPU license.

Step 6 On the Virtual Hardware tab, for the CPU, choose the new value from the drop-down list.
Step 7 For the Memory, enter the new value for the RAM.
Step 8 Click OK.
Step 9 Power on the ASAv. For example, click Power On the Virtual Machine.
Step 10 For failover pairs:

a. Open a console to the active unit or launch ASDM on the active unit.

b. After the standby unit finishes starting up, fail over to the standby unit:

• ASDM: Choose Monitoring > Properties > Failover > Status, and click Make Standby.

• CLI: failover active

c. Repeat Steps 3 through 9 for the active unit.
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What to do next

See Licensing for the ASAv for more information.

Performance Tuning for the ASAv on VMware

Increasing Performance on ESXi Configurations
You can increase the performance for an ASAv in the ESXi environment by tuning the ESXi host CPU
configuration settings. The Scheduling Affinity option gives you control over how virtual machine CPUs are
distributed across the host's physical cores (and hyperthreads if hyperthreading is enabled). By using this
feature, you can assign each virtual machine to processors in the specified affinity set.

See the following VMware documents for more information:

• The Administering CPU Resources chapter of vSphere Resource Management.

• Performance Best Practices for VMware vSphere.

• The vSphere Client online help.

NUMA Guidelines
Non-UniformMemory Access (NUMA) is a sharedmemory architecture that describes the placement of main
memory modules with respect to processors in a multiprocessor system. When a processor accesses memory
that does not lie within its own node (remote memory), data must be transferred over the NUMA connection
at a rate that is slower than it would be when accessing local memory.

The x86 server architecture consists of multiple sockets and multiple cores within a socket. Each CPU socket
along with its memory and I/O is referred to as a NUMA node. To efficiently read packets from memory,
guest applications and associated peripherals (such as the NIC) should reside within the same node.

For optimum ASAv performance:

• The ASAv machine must run on a single numa node. If a single ASAv is deployed so that is runs across
2 sockets, the perfomance will be significantly degraded.

• An 8-core ASAv (Figure 1: 8-Core NUMA Architecture Example, on page 20) requires that each socket
on the host CPU have a minimum of 8 cores per socket. Consideration must be given to other VMs
running on the server.

• The NIC should be on same NUMA node as ASAv machine.

ASAvdoes not support multi-Non-uniform memory access (NUMA) nodes and
multiple CPU sockets for physical cores.

Note

The following figure shows a server with two CPU sockets with each CPU having 18 cores. The 8-core ASAv
requires that each socket on the host CPU have a minimum of 8 cores.
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Figure 1: 8-Core NUMA Architecture Example

More information about using NUMA systems with ESXi can be found in the VMware document vSphere
Resource Management for your VMware ESXi version. To check for more recent editions of this and other
relevant documents, see http://www.vmware.com/support/pubs

Multiple RX Queues for Receive Side Scaling (RSS)
The ASAv supports Receive Side Scaling (RSS), which is a technology utilized by network adapters to
distribute network receive traffic in parallel to multiple processor cores. For maximum throughput, each vCPU
(core) must have its own NIC RX queue. Note that a typical RA VPN deployment might use a single
inside/outside pair of interfaces.

You need ASAv Version 9.13(1) or greater to use multiple RX queues.Important

For an 8-core VM with an inside/outside pair of interfaces, each interface will have 4 RX queues, as shown
in Figure 2: 8-Core ASAv RSS RX Queues, on page 21.
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Figure 2: 8-Core ASAv RSS RX Queues

The following table presents the ASAv's vNICs for VMware and the number of supported RX queues. See
#unique_13 unique_13_Connect_42_section_unm_s52_glb for descriptions of the supported vNICs.

Table 3: VMware Recommended NICs/vNICs

PerformanceNumber of RX
Queues

Driver TechnologyvNIC DriverNIC Card

PCI Passthrough offers the highest
performance of the NICs tested. In
passthrough mode the NIC is
dedicated to the ASAv and is not an
optimal choice for virtual.

8 maxPCI Passthroughi40ex710*

SR-IOVwith the x710 NIC has lower
throughput (~30%) than PCI
Passthrough. i40evf on VMware has
a maximum of 4 RX queues per
i40evf . 8 RX queues are needed for
maximum throughput on a 16 core
VM.

4SR-IOVi40evf

—2SR-IOVixgbe-vfx520

The ixgbe driver (in PCI Passthrough
mode) has 6 RX queues. Performance
is on par with i40evf (SR-IOV).

6PCI Passthroughixgbe

Not recommended for ASAv100.8 maxPara-virtualizedvmxnet3N/A
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PerformanceNumber of RX
Queues

Driver TechnologyvNIC DriverNIC Card

Not recommended by VMware.e1000N/A

*The ASAv is not compatible with the 1.9.5 i40en host driver for the x710 NIC. Older or newer driver
versions will work. See Identify NICDrivers and Firmware Versions, on page 22 for information on ESXCLI
commands to identify or verify NIC driver and firmware versions.

Identify NIC Drivers and Firmware Versions

If you need to identify or verify your specific firmware and driver version information, it is possible to find
that data using ESXCLI commands.

• To get a list of the installed NICs, SSH to the pertinent host and run the esxcli network nic list

command. This command should provide you with a record of devices and general information.

• After you have a list of the installed NICs, you can pull detailed configuration information. Run the
esxcli network nic get command specifying the name of the NIC necessary: esxcli network nic

get –n <nic name>.

General network adapter information can also be viewed from the VMware vSphere Client. The adapter and
driver are found under Physical Adapters within the Configure tab.

Note
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